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Abstract 
Rauvolfia tetraphylla, one of the most medicinally important species, belongs to the 
Apocynaceae family. It produces monoterpenoid indole alkaloids (MIAs) with significant 
pharmacological value, especially for the treatment of neurological disorders and 
hypertension. Strictosidine synthase gene (str1), the crucial gene responsible for the 
production of monoterpene indole alkaloids (MIAs) and its presence substantiates the 
medicinal value of these plants. In this investigation, we successfully analyzed the tissue-
specific (root, stem, and leaf) expression of the str1 gene in different developmental 
stages (4- and 6-month-old plants) in R. tetraphylla through RT-PCR. Normalized ImageJ 
analysis showed high str1 expression in roots (1.005 ± 0.005 to 1.152 ± 0.210 ratios), 
moderate expression in stem (0.242-0.919) and low expression in leaf that decreased with 
age (from 0.702 ± 0.189 at 4-month-old plants to 0.303 ± 0.384 at 6-month-old plant). 
Furthermore, we confirmed the target specificity of str1 by sequencing, which showed 
94.4-94.56% identity with Rauvolfia str1 homologs. As the first report of str1 expression in 
Bangladeshi R. tetraphylla, our findings confirm root tissue as the principal site of alkaloid 
biosynthesis and offer a molecular basis for optimizing cultivation tactics to increase 
production of its therapeutically valuable compounds.  
 

Introduction 
Rauvolfia tetraphylla L., a perennial woody shrub within the Apocynaceae family, is 
recognized for its evergreen foliage, compact growth habit and potential therapeutic 
properties. The common name of this plant is ‘Be Still Tree’ or ‘Devil Pepper tree’ while 
in Bangladesh it called ‘Boro Chador’. Indigenous to the neotropics, its native range 
extends  from Mexico  and  the West Indies through Central America  to  northern  South 
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America, where it thrives in diverse ecological niches (POWO 2024). R. tetraphylla has 
been introduced and naturalized across several regions, including Bangladesh, India, 
Myanmar, Nepal, Pakistan and Sri Lanka, where it adapts to diverse environments 
(Ahmed et al. 2008).  
 R. tetraphylla holds significant medicinal value, particularly in treating hypertension, 
cardiovascular disorders and psychiatric conditions (Sharma et al. 1999, Faisal et al. 
2005). Its roots, rich in bioactive alkaloids, serve as a substitute for R. serpentina in 
traditional medicine (Shenya et al. 2025). The plant exhibits anticonvulsant, diuretic and 
expectorant properties, with latex and leaves used for dropsy, malaria and snakebites 
(Prashith 2019). Additionally, root extracts aid in gastrointestinal ailments, uterine 
stimulation during labor (CSIR 1986) and CNS-related disorders (Harisaranraj et al. 
2009). This plant exhibits pharmacological properties, primarily attributed to its diverse 
alkaloid compounds, mostly monoterpene indole alkaloids (MIAs). According to Farooqi 
and Sreeramu (2001) and Stöckigt et al. (2008), this plant contains reserpine, serpentine, 
ajmaline, vinblastine, quinine, yohimbine, ajmalicine and tetraphyllincine as major 
secondary metabolites which contribute to its therapeutic value in traditional and 
modern medicine. Among them reserpine shows multiple pharmaceutical properties, 
including antihypertensive, antipsychotic, and sedative effects, making it valuable for 
treating chronic hypertension and psychological disorders (Pullaiah 2002 and Duke 
2005). 
 The strictosidine synthase (str1) gene encodes the pivotal enzyme that catalyzes the 
condensation of tryptamine and secologanin to form strictosidine, the universal 
precursor for monoterpenoid indole alkaloids (MIAs) in Rauvolfia species (Stockigt et al. 
2008). This rate-limiting step establishes the scaffold for pharmacologically vital alkaloids 
like reserpine, vinblastine and quinine, making STR1 indispensable for both plant 
defense and medicinal applications (O'Connor and Maresh 2006). Str1 gene was initially 
identified in Catharanthus roseus and Rauvolfia serpentina cell cultures, with subsequent 
characterization in numerous Apocynaceae and Rubiaceae species including Vinca, 
Cinchona, and Ophiorrhiza (De Waal et al. 1995, Hampp and Zenk 1988, Yamazaki et al. 
2003). In 1992 Bracher and Kutchan isolated and partially characterized this gene from R. 
serpentina and R. mannii. The coding DNA sequence (CDS) of this gene contains no 
introns which fact adds to the 17% of the known plant genes which are intron-less. 100% 
sequence homology over 1180 base pairs (conserved region), encompassing the entire 
translated region, exists for str1 between the two Rauvolfia species. The monomeric 
precursor protein with 344 amino acids exhibits 100, 79 and 58% similarities with STR1 
from R. mannii, C. roseus, Ophiorrhiza pumila, respectively (Kutchan et al. 1993). This 
conserved genomic region exhibits specific binding affinity for nuclear proteins across 
multiple Rauvolfia species (R. serpentina, R. mannii, R. verticillata, R. tetraphylla, R. chinensis)  
and Nicotiana plumbaginifolia (Ma et al. 2006, Kutchan et al. 1993).  
 Gene expression analysis through Reverse Transcription PCR (RT-PCR) and band 
intensity quantification provides critical insights into the functional roles of genes like 
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str1 in plant tissues. By measuring mRNA levels, RT-PCR reveals tissue-specific 
expression patterns, helping identify key biosynthetic part of the plant. In R. serpentina, 
str1 gene, are ubiquitously distributed in the plant tissue but show root-dominant 
accumulation, highlighting roots as the primary biosynthetic site (Kutchan et al. 1993). 
Differential str1 expression across tissues (roots >stems >leaves) correlates with varying 
alkaloid concentrations, suggesting transcriptional regulation controls metabolic flux in 
MIAs pathways (Yamazaki et al. 2003). Moreover, RT-PCR analysis enables visualization 
of tissue-specific gene expression patterns, where band intensity on agarose gels 
correlates with transcript abundance-stronger bands indicate higher target gene 
expression levels and reflecting its functional activity in the sampled tissue (Bustin 2002, 
Gachon et al. 2004). Also, this semi-quantitative approach has been widely validated for 
studying gene expression in plant secondary metabolism (Udvardi et al. 2007). 
 For accurate quantification of these expression paĴerns, ImageJ has emerged as an 
essential open-source tool that enables precise measurement and normalization of RT-
PCR band intensities against internal controls (e.g., housekeeping genes). Normalization 
is essential in gene expression studies to minimize technical variability and enable 
accurate biological comparisons by standardizing data against stable reference genes like 
18S rRNA or actin (Livak and SchmiĴgen 2001). Its advanced image analysis capabilities 
not only facilitate reliable cross-sample comparisons but also enhance experimental 
reproducibility in gene expression studies (Abramoff et al. 2004), making it particularly 
valuable for correlating transcriptional activity with alkaloid biosynthesis potential in 
medicinal plants like Rauvolfia species. 
 While the str1 gene has been comprehensively characterized in Rauvolfia serpentina, 
its expression profile and functional role in the closely related R. tetraphylla, an equally 
important producer of pharmaceutically valuable indole alkaloids, remain unexplored. 
This study represents the first systematic investigation of str1 expression dynamics in 
Bangladesh, examining both developmental (4- vs 6-month-old plants) and tissue-specific 
(root, stem, leaf) patterns in R. tetraphylla using conserved str1 gene sequences from R. 
serpentina, R. mannii and R. verticillata. Our findings will address critical gaps in 
understanding the spatiotemporal regulation of alkaloid biosynthesis in this 
understudied medicinal species, providing a foundation for future biotechnological 
applications. 
 

Materials and Methods 
R. tetraphylla plants were propagated using previously optimized tissue culture protocol 
(Hoque et al. 2020), followed by greenhouse acclimatization (Fig. 1). Samples were 
collected from roots, stems, and leaves of 4-month (juvenile) and 6-month (mature) 
plants for analysis. Three STR1-specific primers were designed using OligoCalc software 
with optimized parameters (45-65% GC content, 54-62°C Tm, 20-25 bp length, 100-200 bp 
amplicons) with sequences sourced from R. serpentina and validated against conserved 
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domains in R. mannii and R. verticillata through NCBI BLAST and MUSCLE alignment 
analyses. The primers were subsequently synthesized by Macrogen (South Korea) 
following stringent quality control measures. DNA isolation was carried out by using 
manual protocol established by Plant Breeding and Biotechnology laboratory, 
Department of Botany, University of Dhaka to check the primers authenticity. Also, 18S 
rRNA was used as a housekeeping gene. Total plant RNA was isolated from different 
plant samples (leaf, stem and roots of four- and six-month-old plants) using Thermo 
Scientific GeneJET RNA Purification Kit as per the manufacturer’s protocol. Isolated 
RNA samples were treated with DNase I and quantified via Nanodrop (A260/A280 >1.8). 
First strand cDNA synthesis was carried out using Thermo Scientific RevertAid First 
Strand cDNA Synthesis Kit according to the manufacturer’s instructions. 
 

 
 

Fig 1. Four-month (lower pots) and six-month-old (upper pots) R. tetraphylla plants used as experimental 
material for the study. 

 
 Expression of the str1 gene was checked by reverse transcriptase PCR (RT-PCR) as 
described by Sambrook and Russell 2001. For the analysis, 50 ng of cDNA template was 
used per reaction in a standardized 25 µL reaction volume. The programming of thermal 
cycler for the PCR amplification was as follows: 30 cycles consisted of initial denaturation 
of 95°C for 5 min then denaturation at 94°C for 1 min, annealing at 58-60°C for 30 sec., 
extension at 72°C for 1 min and a final extension at 72°C for 10 min. After that, PCR 
products were resolved on 1.5% agarose gel and bands intensity were observed. 
 The cDNA band intensities from RT-PCR analysis of R. tetraphylla were quantified 
using ImageJ (v1.53) following a standardized protocol. For both the target str1 gene and 
the reference 18S rRNA housekeeping gene, gel images were converted to 8-bit grayscale, 
contrast-enhanced (Image >Adjust >Brightness/Contrast) and inverted (Edit >Invert). 



Tissue-Specific Expression Profiling of Strictosidine Synthase (str1) 133 
 
Lanes were defined using the rectangular selection tool, and intensity profiles were 
generated (Analyze >Gel >Plot Lanes). Band intensities were measured by selecting peaks 
in the lane profile plots with the wand tool, with the area under each peak recorded as 
relative intensity values. The str1 expression levels were normalized against 18S rRNA by 
calculating the ratio of their respective band intensities. All data was exported to Excel 
for comparative analysis across different ages (4- and 6-month-old plants) and tissues 
(root, stem, leaf). 
 For sequencing, amplified products were purified using ethanol precipitation by 
adding 2.5 volumes of ice-cold 100% ethanol, incubating at −20°C for 30 min and 
centrifuging at 12,000 g for 15 min. The DNA pellet was washed with 70% ethanol, air-
dried and resuspended in nuclease-free water for downstream applications. Sanger 
sequencing was conducted at the University of Dhaka's Centre for Advanced Research in 
Sciences (CARS) to sequence the amplified STR1 fragment unidirectionally (forward 
primer). To confirm the presence of str1 conserved region in R. tetraphylla, the sequence 
was aligned to R. serpentina, R. mannii and R. verticillata str1 (NCBI Accession number: 
Y00756, X63431 and DQ017054 respectively) after being base-called and trimmed (Q20 
threshold) by using MEGA.  
 

Results and Discussion 
Three STR1-specific primers (STR1-1, STR1-2, and STR1-3) from multiple aligned 
sequence of str1 from R. serpentina, R. verticillata and R. mannii were designed (Table 1). 
Genomic DNA was successfully isolated from all tissue samples (roots, stems, and 
leaves) of both 4- and 6-month-old R. tetraphylla plants and subsequently employed as 
template for preliminary PCR optimization of STR1-specific primer sets. Of the three  
 
Table 1. Designed primer sequences of str1 for RT-PCR analysis. 
 

Primer’s name Sequence  Amplification at  
(bp) 

STR1_FOR1 5´-ATG GCC AAA CTT TCT GAT TCG C-3´ 
160 

STR1_REV1 5´-CTTTGTTGGTTGAGTCGAAGGTG-3´ 

STR1_FOR2 5´-CTATTATCATCTTTCTGTGGTTGG-3´  
142 

STR1_REV2 5´-GCTAACATCGGTGAAGTAAACAATC-3´ 

STR1_FOR3 5´-GATGAGTTTGGGAACATTCTTGAAG-3´ 
180 

STR1_REV3 5´-GAAAATTTAATGACTTGAAACAAAAGAAT-3´ 

 

primers tested, STR1-1 and STR1-2 generated clear, reproducible amplicons of the 
expected sizes (160 bp and 142 bp, respectively) across all tissue types (Fig. 2a). Parallel 
amplification of the 18S rRNA housekeeping gene yielded a 101 bp fragment (Fig. 2a), 
confirming RNA integrity and enabling expression normalization. The precise 
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correspondence between observed and designed amplicon lengths confirms successful 
primer optimization and target-specific amplification. These validated primers were 
subsequently used for comparative expression analysis of str1 across developmental 
stages and tissue types. 
 Total RNA was isolated from stems, leaves, and roots of both 4- and 6-month-old R. 
tetraphylla plants and the RNA integrity was checked by 1% agarose gel electrophoresis 
(Fig. 2b), which revealed distinct 28S and 18S ribosomal RNA bands demonstrating 
suitability for downstream cDNA synthesis and RT-PCR applications. cDNA was 
prepared after RNA isolation by reverse transcription reaction. Then str1 gene expression 
in stem, leaf and root of four- and six-month-old plants were observed by RT-PCR.  
 

 
 

Fig. 2. Gel electrophoresis analysis. (a) Check PCR bands of primers and housekeeping gene; first lane indicate 
18S rRNA (housekeeping gene), second lane = 1 kb ladder, third and fourth lane = str1 primers; (b) isolated 
RNA bands; lane 1-9 (left) indicates four-month-old plants (R4), lane 1-9 (right) indicates six-month-old 
plants (R6); S=Stem, L=Leaf, R=Root and, each stage with 3 replicates.  

 
RT-PCR analysis of R. tetraphylla revealed distinct expression patterns for the str1 gene 
across tissues and developmental stages (Fig. 3a-b). In both 4- and 6-month-old plants, 
root samples consistently showed the strongest amplification bands for both STR1-1 and 
STR1-2 primers, indicating high str1 expression. Stem tissues displayed variable band 
intensities, with some replicates exhibiting noticeably low amplification. Leaf samples 
produced the weakest bands in most cases, except for trace amplification in a few 
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replicates. The STR1-1 primer generally yielded more consistent banding patterns across 
replicates compared to STR1-2, which showed greater variability in stem and leaf 
samples. The 18S rRNA amplification patterns confirmed RNA integrity across all 
samples. Strong, consistent bands of equal intensity were observed in all root, stem, and 
leaf samples from both 4- and 6-month-old plants (Fig. 3a-b). These qualitative 
observations from agarose gel electrophoresis suggest that str1 expression is 
predominantly localized to root tissues, with limited activity in stems and minimal 
detection in leaves. 
 

 
 

Fig. 3. Gel electrophoresis analysis of str1 expression in different parts of R. tetraphylla. (a) str1 expression in 
different parts of four-month-old R. tetraphylla. b) str1 expression in six-month-old R. tetraphylla plants in 
different tissues. Gel pictures show RT-PCR bands of 2 set primers (STR1-1 and STR1-2) and housekeeping 
gene 18S rRNA amplified with R. tetraphylla. Lane R1-R3 indicate roots samples, S1-S3 indicate stem 
samples and lane L1-L3 indicate leaf samples, lane M is 100 bp ladder; arrow indicates the expected band 
size. 

 
 Moreover, str1 expression was assessed via semi-quantitative RT-PCR, with band 
intensities quantified using ImageJ and normalized to 18S rRNA. In this approach, plot 
lane profile of the gel pictures were created to analyze the intensity of the peaks of the 
bands. The area under the peak represents the band intensity (Fig. 4a-c). The data of band 
intensity and normalized ratio was presented in Table 2 and the result showed distinct 
tissue-specific and age-dependent patterns across root, stem, and leaf tissues at 4 and 6 
months of age. 
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Fig. 4. Plot lane analysis of str1 expression in different tissue of R. tetraphylla using the RT-PCR gel image: (a) 
Band area intensity peak of str1 in different part of four-month-old R. tetraphylla, (b) Band area intensity 
peak of str1 in roots of six-month-old R. tetraphylla, (c) Band area intensity peak of str1 in stems and leaves 
of six-month-old R. tetraphylla. Every panel shows peaks: Top: STR1-1 primer, Middle: STR1-2 primer and 
bottom: 18S rRNA. Every band is represented by a peak. (Light yellow peak= root samples, lime green 
peak= stem samples and dark green mark= leaf samples). 

 
Mean 18S rRNA intensity (30814.1) confirms adequate cDNA input. In root tissues, both 
isoforms exhibited relatively high and stable expression, with STR1-1 showing consistent 
ratios (1.005 ± 0.005 at 4M; 1.054 ± 0.172 at 6M) and STR1-2 displaying slightly higher but 
more variable expression (1.152 ± 0.210 at 4M; 1.100 ± 0.300 at 6M), suggesting robust 
transcriptional activity in roots regardless of age. This high and stable expression of 
STR1-1 and STR1-2 in roots aligns with previous reports that MIA biosynthesis is root-
predominant in many Apocynaceae species, including Catharanthus roseus (Guirimand et 
al. 2010), Rauvolfia sp. (Stockigt et al. 2008). Similarly, Bracher and Kutchan (1992) 
reported the expression of str1 in R. serpentina. They revealed that R. serpentina roots 
show the highest strictosidine synthase (STR1) activity, while leaves and stems have 
minimal expression, matching the plant's alkaloid distribution pattern. According to 
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Court’s (1983) experiment with alkaloid distribution analysis of African Rauvolfia species, 
simpler alkaloids were found in aerial parts of the plant and the more complex 
dihydroindole alkaloids were found mainly in the roots.  
 
Table 2. RT-PCR analysis of str1 expression in R. tetraphylla: ImageJ-derived band intensities (area values) 

and normalized (STR1/18S rRNA) ratios for root, stem and leaf tissues at different ages. 
 

Tissue Age 
(month old) 

Replicate Band intensity 
(STR1-1) area 

Band intensity 
(STR1-2) area 

Band intensity 
(18S rRNA) area 

STR1-1/18S 
rRNA ratio 

STR1-2/18S 
rRNA ratio 

 
Root 

 

 
4 

R1 33540.7 31978.5 33538.5 1.000 0.953 
R2 29518.5 33143.9 29.357.6 1.006 1.129 
R3 30242.7 41176 29976.5 1.009 1.374 

Mean ± SD 1.005 ± .005 1.152 ± 0.210 

 
Root 

 

 
6 

R1 34449.3 40424.5 34335.8 1.003 1.177 
R2 46881.8 51102.7 37517.4 1.250 1.362 
R3 38704 32451.3 38570.3 0.909 0.762 

Mean ± SD 1.054 ± 0.172 1.100 ± 0.300 
 

Stem 
 

 
4 

S1 26210.1 30784.7 31984.5 0.819 0.962 
S2 10800.3 16342.8 44682 0.242 0.366 
S3 25277.9 26613.1 27507.3 0.919 0.967 

Mean ± SD 0.660 ± 0.389 0.765 ± 0.324 
 

Stem 
 

 
6 

S1 25362 27539.3 36376.3 0.697 0.757 
S2 33761.6 33260 37250.6 0.906 0.893 
S3 25493.3 3526.55 26660.7 0.956 0.132 

Mean ±SD 0.853 ± 0.133 0.594 ± 0.418 

 
Leaf 

 

 
4 

L1 23004.2 25158.1 47822.1 0.481 0.526 
L2 22426.1 21609.2 27875.5 0.805 0.775 
L3 13697.6 78.899 16724.8 0.819 .005 

Mean ± SD 0.702 ± 0.189 0.435 ± 0.434 
 

Leaf 
 

6 
L1 1549.82 3524.94 42969 0.036 0.082 
L2 4324.85 1089.55 37419.9 0.116 0.029 
L3 31367.4 11125.7 41352.7 0.758 0.269 

Mean ± SD 0.303 ± 0.384 0.127 ± 0.130 

 

 In contrast, stem tissues demonstrated lower overall expression, particularly at 4 
months, where STR1-1 ratios varied widely (0.242-0.919), possibly indicating 
developmental or regulatory fluctuations. By 6 months, stem expression became more 
stable for STR1-1 (0.853 ± 0.133), though STR1-2 showed extreme variability (e.g., 0.132 in 
S3 vs. ~0.8 in S1/S2), which may reflect tissue heterogeneity or experimental noise. These 
findings align with Yamazaki et al. (2003), who similarly reported differential str1 
expression across tissues in R. serpentina, supporting the concept of tissue-specific 
metabolic partitioning in alkaloid biosynthesis. The consistent root-dominant activity 
further validates the spatial regulation of alkaloid production in R. serpentina.  
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 Leaf tissues displayed higher decline in str1 expression with age, as STR1-1 dropped 
from 0.702 ± 0.189 at 4M to 0.303 ± 0.384 at 6M, and STR1-2 nearly diminished (0.127 ± 
0.130 at 6M), with some replicates (e.g., L1, L2) approaching undetectable levels. While 
leaves are major sites for photosynthesis and secologanin production, they may rely on 
root-derived strictosidine rather than local biosynthesis. This is corroborated by studies 
in C. roseus showing that leaf STR transcripts are often undetectable unless induced by 
stress (Menke et al. 1999).   
 Our semi quantitative analysis aligns well with qualitative gel observations, where 
root bands were consistently intense, stem bands appeared moderate but variable, and 
leaf bands weakened significantly with age, particularly for STR1-2. The outliers in stem 
and leaf datasets (e.g., S3-STR1-2, L3-STR1-1) likely correspond to faint but detectable 
bands in gels, reinforcing the importance of biological and technical replicates in 
interpreting expression trends. Overall, the data highlight strong tissue specificity (roots 
>stems >leaves) and an age-dependent suppression of str1 isoforms in leaves, suggesting 
potential regulatory mechanisms tied to developmental stages or environmental 
adaptations. 
 For further confirmation, STR1-1 forward primer was sequenced, and the resulting 
sequence was submitted to NCBI with the accession number PV600355. A nucleotide 
BLAST (blastn) was performed against the NCBI database to verify its identity. The 
findings showed that strictosidine synthase (str1) genes from several Rauvolfia species 
shared a high degree of similarity (94.4-94.56% identical) including- R. serpentina (94.40-
94.56% identity; accessions: X62334.1, Y00756.1), R. mannii (94.56% identity; Accession: 
X63431.1;), R. verticaliata (94.56% identity; Accessions: DQ872163.1, DQ017054.1). Thus, 
we confirmed that the sequenced segment was part of strictosidine synthase (str1) gene 
by 90% query coverage, nearly similar Max Scores (955-961), and E-values of 0.0 
(showing high confidence) for all hits (Table 3). These findings support the primer's 
specificity and suitability for more research on str1 expression in Apocynaceae. 
 

Table 3. NCBI BLAST analysis of str1 sequence of Rauvolfia tetraphylla against Rauvolfia homologues. 
 

Species Max 
score 

Query 
cover 

E-value Identity 
percentage 

Accession Publication 

R. serpentina 961 90% 0.0 94.56% X62334.1 Bracher and Kutchan (1992) 

R. serpentina 955 90% 0.0 94.40% Y00756.1 Kutchan et al. (1988) 

R. verticillata 961 90% 0.0 94.56% DQ872163.1 Chan et al. (2008) 

R. verticillata 961 90% 0.0 94.56% DQ017054.1 Chen et al. (2008) 

R. manni 961 90% 0.0 94.56% X63431.1 Bracher and Kutchan (1992) 
 

 With its major activity in roots, less so in stems, and barely detectable in leaves, our 
study offers thorough evidence for tissue-specific and developmental regulation of str1 
expression in R. tetraphylla. This investigation covers a significant knowledge gap on the 
alkaloid production of R. tetraphylla, a medicinal plant cultivated in Bangladesh, by 
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offering the first comprehensive examination of str1 expression in this plant. The 
trustworthiness of our experimental method is demonstrated by the successful design 
and validation of STR1-specific primers as well as sequence confirmation using NCBI 
BLAST analysis (94.4-94.56% identity with Rauvolfia STR1 homologs). These results 
support the evolutionary conservation of strictosidine synthase's root-dominant 
expression. Our findings set a critical foundation for further research on the secondary 
metabolism of R. tetraphylla and offer insightful information for improving cultivation 
techniques to increase the yield of its pharmacologically active chemical compounds.  
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